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I. HƯỚNG DẪN CÀI ĐẶT 

I.1 Yêu cầu cấu hình 

I.1.1. Dành cho những máy dùng hệ điều hành Window 

 

Hệ điều hành Win 10 

Win 8.1 

Windows 7 SP1 (Phải cài bảng cập nhật Platform 

KB2670838 and Security KB4012215) 

 

Dung lượng ổ đĩa tối thiểu 4,7 GB 

Thông số kỹ thuật tối thiểu cho màn hình độ nét tiêu chuẩn và độ phân giải cao 

(lên tới 1080p và tương tự). 

Bộ xử lý tối thiểu Intel Core 2 Duo 

Ram tối thiểu 2GB 

Thông số kỹ thuật tối thiểu cho màn hình độ nét cực cao (4K) 

Card đồ hoạ tối thiểu Integrated GPU 

Bộ xử lý tối thiểu With integrated* GPU: Intel Core i3 

With discrete GPU: Intel Core 2 Duo 

Ram tối thiểu 4GB 

Những yêu cầu khác 

Chương trình Microsoft .NET Framework 4.5.1 Cho phần mềm 

SMART Notebook  và SMART Ink 

Microsoft Visual Studio Tools 2010 for Office cho 

SMART Ink 

Adobe Reader 8.0 hoặc cao hơn 

Công nghệ DirectX 10 hoặc cao hơn cho phần mềm  

SMART Notebook 

 

I.1.2. Dành cho hệ điều hành MAC OS. 

Hệ điều hành được hỗ trợ MAC OS High Sierra (10.13) 

MAC OS Sierra (10.12) 

OS X El Capitan (10.11) 

Dung lượng ổ đĩa tối thiểu 2,3 GB 

Thông số kỹ thuật tối thiểu cho màn hình độ nét tiêu chuẩn và độ phân giải cao 

(lên tới 1080p và tương tự). 

Bộ xử lý tối thiểu Intel Core 2 Duo 

Ram tối thiểu 2GB 

Thông số kỹ thuật tối thiểu cho màn hình độ nét cực cao (4K). 

Hệ thống đề xuất Late 2013 Retina MacBook Pro or later 

Ram  8 GB 
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I.2 Các bước cài đặt trên Window.

Vào thư mục giải nén chạy file cài 

đặt 

Xuất hiện giao diện giới thiệu 

phiên bản → chọn Next để tiếp 

tục. 

Chọn ‘I accept the terms in the 

license agreement’. 

Chọn Next. 

Chọn Next. 

Chú ý: Chọn ‘Change…’ nếu 

muốn thay đổi thư mục để cài vào, 

mặc định như đường dẫn bên 

dưới. 
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Chọn những ứng dụng cài vào  

máy → Next. 

Chọn Next. 

Chọn Next. 
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Chọn ngôn ngữ cài đặt → chọn 

Next. 

 

Chọn Install quá trình cài đặt sẽ 

mất một vài phút tuỳ theo cấu hình 

máy tính. Trong quá trình cài đặt, 

xuất hiện thông báo → chọn Next. 

 

Sau một vài phút cài đặt khi xuất 

hiện giao diện hoàn thành cài đặt 

chọn → Finish. 

 

 



                                                                                                             

 Trang - 7 -  
 

HDSD SMART NOTEBOOK 

Sau khi cài đặt mặc định chương 

trình dùng thử trong 45 ngày. 

Nhập key kích hoạt bản quyền ta 

làm như sau: trên giao diện màn 

hình chọn Help → Software 

Activation… sau đó chọn Add để 

mở giao diện nhập key. 

   + Enter your product key : nhập 

key vào đây 

   + Add: Thêm key vào danh sách 

   + I accept the terms in the 

….:chọn vào đây để chấp nhận. 

   + Next: nhấn vào để kết thúc.  
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II. TỔNG QUAN 

II.1 Giới thiệu. 

Giao diện phần mềm SMART Notebook gồm có các thành phần: 
- Thanh trình đơn (Menu). 

- Thanh công cụ (Toolbar). 

- Thanh bên (Side Bar). 

- Trang soạn thảo (Page). 

- Tùy chỉnh thanh công cụ (Customize the toolbar). 

 

II.1.1. Thanh trình đơn (menu). 

Thanh trình đơn chứa tất cả các lệnh để bạn sử dụng thao tác với tệp tin và đối 

tượng. Bao gồm các phần: 

 
 

- Tệp tin (File): Nơi tạo mới, lưu  tập tin. Chuyển đổi định dạng, chia sẻ tập tin 

của chương trình, ... 

- Hiệu chỉnh (Edit): Tập trung các lệnh sao chép, xoá, chỉnh sửa trang,…. 

- Xem (View): Cho phép hiệu chỉnh giao diện của chương trình, chế độ hiển thị, 

chuyển đổi ngôn ngữ, … 

- Chèn (Insert): Thêm trang mới, hình ảnh, âm thanh, bảng, liên kết,… 

- Định dạng (Format): Định dạng trang, hình ảnh, văn bản, khoá đối tượng,… 

- Công cụ (Tools): Nơi chứa các thanh công cụ của chương trình như: bút, hình 

dạng, cục tẩy,  … 

- Các công cụ hỗ trợ (Add-ons): Nơi quản lý các ứng dụng kèm theo, dùng để 

đóng/mở các ứng dụng tại đây. 

- Tài khoản (Account):Quản lý tài khoản khi tạo lớp học online. 
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- Trợ giúp (Help): Thông tin phiên bản của chương trình, cũng như đăng nhập, 

xem mã bản quyền. 

II.1.2. Thanh công cụ (ToolBar). 

Bao gồm 3 nhóm: 

Phần các nút thao 

tác cơ bản 

 

  

Phần Add-ons 

 

 

 

 

 

 

 

 

 

 

 

 

 

Phần công cụ cơ 

bản 

 

 

 

 

 

 

 

 

 
Thuộc tính công cụ: 

 

II.1.3. Thanh bên (Side Bar). 
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II.2 Thao tác với tệp tin. 

Thao tác Nội dung 

Tạo mới Để tạo mới thì trên thanh trình đơn (Menu) chọn Tệp tin (File) → 

Notebook mới (New). 

Lưu Trên thanh trình đơn (Menu) chọn Tệp tin (File), khi đó có hai sự 

lựa chọn. 

 Lưu (Save): Nếu tệp tin mới tạo ra thì sẽ giống như Lưu dưới 

dạng (Save As), còn nếu lưu lại một tệp tin đã có 

sẵn thì sẽ lưu trực tiếp tại tệp tin đó. 

Lưu dưới 

dạng (Save 

As): 

Sẽ lưu thành một tệp tin mới. Khi chọn Lưu dưới 

dạng (Save As) bạn sẽ phải dẫn tới nơi cần lưu lại 

và nhấn Lưu (Save). 

Mở một tệp tin có 

sẵn 

Trên thanh trình đơn chọn Tệp tin (File) → Mở (Open). Khi đó 

bạn sẽ phải dẫn tới nơi lưu tệp tin cần mở và nhấn Mở (Open). 

Nhập vào một tệp 

tin khác loại 

 

- Lưu ý: Đối với phần mềm SMART Notebook thì sẽ có định 

dạng là *.notebook.  

- SMART Notebook hỗ trợ nhập vào các định dạng của các phần 

mềm khác như PowerPoint (*.ppt, *.pptx); Promethean (*.flp) ; 

XML Paper (*.xps); các tệp tin có đuôi  IWB (*.iwb). 

 
- Cách nhập: Tại thanh trình đơn chọn Tệp tin (File) → Nhập vào 

(Import). Khi đó bạn cần phải chọn định dạng nhập vào và sẽ phải 

dẫn đến nơi chứa tệp tin cần nhập vào và chọn Open. 

Xuất ra tệp tin khác 

loại 

- SMART Notebook: Hỗ trợ xuất ra các định dạng của các phần 

mềm khác như PowerPoint, tệp tin hình ảnh, tệp tin website, tệp 

tin PDF… 

- Cách xuất: Tại thanh trình đơn chọn Tệp tin (File) → Xuất ra. 

Khi đó bạn cần phải chọn định dạng xuất ra và sẽ dẫn đến nơi nào 

đó trên máy tính và chọn Save (Lưu) để lưu lại tệp tin vừa xuất. 

 

Thiết lập thời gian 

tự động lưu 

*Thời gian tự động lưu là mốc thời gian sau một khoảng thời 

gian bài đang soạn sẽ tự động lưu. Để thiết lập thì làm như sau: 
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Thao tác Nội dung 

- Chọn Tệp tin ( File) →  Thời gian tự động lưu (Timed Saves) 

 

- Có 6 lựa chọn sau để lưu tự động sau khoảng thời gian: 

+ Không tự động lưu tài liệu (Do not save the document 

automatically). 

+ Chọn Mỗi lần sang trang mới (Every time I move to a 

different page) để lưu lại tự động khi mỗi lần bạn sang trang khác. 

+ 1 phút (1 minute). 

+ 5 phút (5 minutes). 

+ 15 phút (15 minutes). 

+ 30 phút (30 minutes). 

- Chọn Tiếp (Next). 

 

- Chọn định dạng cần lưu: người dùng tự chọn kểu định dạng tệp 

tin (Notebook Document, PowerPoint, tệp tin PDF…) 

- Chọn tiếp (Next). 

- Cửa sổ nơi lưu lại sẽ xuất hiện → Lưu (Save). 

II.3 Tạo và làm việc với trang. 

-Tạo mới và chèn trang mới: để tạo trang mới thì sẽ có 3 cách như sau: 
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STT Nội dung 

Cách 1 Tại trang cuối cùng chọn  trên thanh công cụ (ToolBar).  

Lưu ý: trang cuối cùng phải chứa đối tượng bất kỳ thì biểu tượng 

 mới hiện lên. 

Cách 2 
Tại phần quản lý trang , chọn trang bất kỳ và chọn chuột 

phải hoặc chọn biểu tượng   → chọn chèn trang trắng ( 

Insert Blank Page). 

 

Cách 3 Tại trang cần chèn (tạo mới) nhấn tổ hợp phím Ctrl+M. 

- Các thao tác trên trang khác. 

Thao tác Hình ảnh minh họa 

Nhân đôi trang Tại trang cần nhân đôi nhấn tổ hợp phím Ctrl + D để 

nhân đôi, hoặc chọn vào   → Nhân đôi (Clone 

Page). 

Cắt, dán, sao chép trang Tại trang cần thao tác nhấn tổ hợp phím Ctrl + V nếu 

muốn cắt, Ctrl + C nếu muốn sao chép, Ctrl + V nếu 

muốn dán. Hoặc có thể chọn vào biểu tượng  để 

thực hiện các lệnh cắt (Cut), dán (Paste), sao chép 

(Copy) trang. 

Đặt nền cho trang  

+ Tại trang cần đặt nền chọn 

chuột phải hoặc chọn vào biểu 

tượng   → Đặt nền (Set 

Background Fill) : 

+ Khi đó bên thanh bên sẽ xuất 

hiện thuộc tính hiệu ứng tô đầy 

(Fill Effects) bao gồm: 

• Không màu nền (No fill). 

• Màu đơn (Solid fill). 

• Trộn màu (Gradient fill). 

• Hoa văn (Pattrn fill). 

• Hình ảnh (Image fill). 
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Thao tác Hình ảnh minh họa 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

- Chi tiết thay đổi nền cho trang. 

Thao tác Hình ảnh minh họa 

Không nền (No Fill): Chọn nếu không muốn có nền trang. 

Màu đơn (Solid Fill): Chọn nếu 

muốn trang được tô đầy bởi một 

màu nào đó. Khi đó bạn cần 

chọn một màu nền cho trang. 

 

 
Trộn màu (Gradient fill): Chọn 

nếu muốn trang được tô đầy bởi 

sự kết hợp giữa hai màu sắc khác 

nhau. Khi đó bạn cần chọn Màu 

thứ nhất (Color one), Màu thứ 

hai (Color two). Cuối cùng chọn 

hình thức pha trộn (Style). 
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Thao tác Hình ảnh minh họa 

Hoa văn (Pattern fill): Chọn nếu 

muốn đặt nền bằng các mẫu hoa 

văn có sẵn.  

 

 
Hình ảnh (Image fill): Chọn nếu 

muốn đặt nền bằng hình ảnh có 

sẵn. Khi đó phải duyệt tới nơi 

chứa hình ảnh cần đặt nền. 

 

II.4 Tạo và làm việc với đối tượng. 

II.4.1. Hình dạng 

- Đối tượng bao gồm: Văn bản, hình ảnh, hình dạng, video, âm thanh, các nét bút, 

bảng, … 
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II.4.1.1. Vẽ hình dạng: 

Để vẽ một hình dạng thì cần làm những bước sau: 

Thao tác Hình ảnh minh họa 

Trên thanh công cụ 

(ToolBar) chọn biểu 

tượng hình dạng, sau 

đó chọn loại hình dạng. 

 
 

Chọn màu sắc cho hình 

dạng. 

 

 

Chọn loại viền. 

 

 
Điều chỉnh độ trong 

mờ cho hình dạng. 

 

 
II.4.1.2. Thao tác với hình dạng. 

-  Các ẩn/hiện: Chọn vào hình dạng vừa vẽ. Sau đó chọn  . Khi đó sẽ có các lựa chọn 

sau: 

+ Ẩn/ hiện số đo các góc: hiển thị số đo các góc. 

- Ẩn/hiện các nút điều chỉnh: sẽ hiển thị các nút điều chỉnh, cho phép tùy biến hình dạng. 

+ Ẩn/hiện độ dài: sẽ hiển thị độ dài đường thẳng, các cạnh. 

- Phân chia hình dạng (devide):  



                                                                                                             

 Trang - 16 -  
 

HDSD SMART NOTEBOOK 

Bạn có thể phân chia hình dạng ra các phần bằng nhau. 

+ Chọn hình dạng cần phân chia.  

+ Chọn vào biểu tượng  

+ Chọn Phân chia hình dạng (Devide). Khi đó xuất hiện cửa sổ. 

 
+ Nhập số phần cần phân chia và chọn đồng ý (OK) để hoàn tất. 

II.4.2. Văn bản. 

Cách nhập văn bản trên SMART Notebook: 

 

 

Thao tác Ảnh minh họa 

Trên thanh công cụ (ToolBar) chọn biểu tượng văn bản. 

Định dạng văn bản. 

 

 
Chọn một vị trí nào đó 

trên trang để nhập văn 

bản.  

 
 

II.4.3. Đường thẳng. 

Các bước vẽ đường thẳng. 

Thao tác Ảnh minh họa 

Chọn để vẽ đường 

thẳng. 

 

 

Chọn dạng đường 

thẳng muốn vẽ. 

Thiết lập thuộc tính 

cho đường thẳng 

như: màu sắc, độ 
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dày, dạng, độ trong 

mờ 

 

II.4.4. Nét bút. 

- Phân loại. 

Loại bút Nét vẽ Chú thích 

Bút thường 
 

Sử dụng để chú thích, giảng giải. 

Bút thư pháp 
 

Dùng để viết những loại chữ kiểu. 

Bút sáp 
 

Sử dụng trong môn nghệ thuật, tô 

ảnh. 

 

Bút dạ quang 

 

Nhấn mạnh một đoạn văn bản nào 

đó. 

Bút văn bản 
 

Nhận dạng và chỉnh sửa văn bản. 

Bút hoa văn 

 

Tạo các hoa văn. 

Bút sơn 

 

Dùng để vẽ. 

Bút thần kỳ 
Dùng làm đèn chiếu, phóng to để nhấn mạnh một đối tượng nào 

đó. 

Bút nhận dạng 

hình dạng 

Tự động nhận diện hình dạng khi vẽ trên trang. 

- Cách sử dụng.       

Thao tác Hình ảnh minh họa 

Trên thanh công cụ chọn biểu 

tượng cây bút. 
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Thao tác Hình ảnh minh họa 

Chọn loại bút 

 

 
 

Chọn nét bút 

  

Chọn màu bút 

 

 
Dạng nét bút 

 

 
Điều chỉnh độ trong mờ.  
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* Ghi chú: để xóa các nét bút thì dùng tẩy: 

- Trên Thanh công cụ chọn biểu tượng  sau đó chọn nét bút đã vẽ để xóa. 

II.4.5. Tô đầy. 

- Để đổ màu cho hình dạng hay khoảng không gian nào đó thì sử dụng công cụ Tô đầy 

(Fill). 

+ Trên thanh công cụ chọn công cụ Tô đầy . 

+ Chọn màu và độ trong mờ. 

 

+ Đổ lên trên đối tượng hình dạng, hay khoảng trống bất kỳ muốn đổ màu. 

II.4.6. Bảng. 

II.4.6.1. Tạo bảng. 

Thao tác Ảnh minh họa 

Trên thanh công cụ (ToolBar) 

chọn , kéo chọn số ô của 

bảng. 

 

 
- Có thể chọn vào Tùy chỉnh 

bảng (Custom Table) để nhập 

trực tiếp số hàng, số cột. 

- Nhập số cột (Colum), số hàng 

(Row)→ Ok 

 

 

* Lưu ý: Mặc đinh của phần mềm khi chèn bảng là những ô hình chữ nhật. Nếu 

muốn dạng hiển thị bảng là những ô hình vuông thì chọn vào ô ‘Hiển thị ô hình 

vuông’(Make cells square). 
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II.4.6.2. Thao tác với bảng. 

Thao tác Ảnh minh họa 

    Tạo màn che: 

Chọn vào bảng, nhấp chuột phải 

hoặc chọn vào , khi đó sẽ có 

trình đơn hiện ra → Thêm màn che 

(Add cell shade). 

Chọn vào màn che thì nó sẽ kéo 

ra, thu lại để ẩn hiện nội dung bên 

trong của bảng. 

     Xóa màn che: 

Chọn vào bảng, nhấp chuột phải 

hoặc chọn vào , khi đó sẽ có 

trình đơn hiện ra → Xóa màn che 

ô (Remove cell shade). 

 

 

Phân chia ô: chọn ô cần phân chia → chọn vào  → Chia ô (Split Cell). Khi đó 

sẽ có 6 lựa chọn như sau: 

•  Chia thành 2 cột. 

•  Chia thành 2 hàng. 

•  Chia thành 2x2. 

•  Chia thành 3 cột. 

•  Chia thành 3 hàng. 

•  Chia thành 3x3. 

 

Xóa dòng, cột: chọn dòng, cột cần xóa → chọn vào  → chọn xóa dòng (delete 

row)/cột (delete column). 

 

 

- Chú ý: Cũng có thể tạo màn che riêng cho từng ô, bằng cách chọn vào ô đó và nhấp 

vào   → Thêm vào màn che ô (Add cell shade). Để xóa thì cũng chọn vào ô cần 

xóa, nhấp vào  → Xóa màn che ô (Remove cell shade).  

II.4.7. Hình ảnh. 

II.4.7.1. Chèn hình ảnh. 

- Tại Thanh trình đơn (Menu) chọn Chèn (Insert). Khi đó sẽ có một cửa sổ trình duyệt 

xuất hiện. 

- Duyệt tìm hình ảnh trong máy và nhấn Open để chèn hình ảnh. 

II.4.7.2. Thao tác với ảnh. 

- Sau chèn vào một hình ảnh, chọn vào ảnh giữ  và kéo để phóng to, thu nhỏ. 

Màn che đã thu lại 
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-  Chọn vào biểu tượng  để thực hiện các cắt, dán, sao chép, nhân đôi, liên kết với 

công cụ, tệp tin, trang…v…v.. 

II.4.7.3. Công cụ làm trong suốt nền của ảnh. 

Nếu không muốn hình ảnh có nền thì làm như sau: 

Thao tác Ảnh minh họa 

Chèn ảnh vào trong trang. 

 

 

Chọn vào biểu tượng  → Làm trong 

suốt nền ảnh (Set Image 

Transparency…). 
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Lúc này con trỏ chuột chuyển thành 

ống hút mực. Bây giờ muốn cho nền 

trong suốt thì nhấp chọn vào phần nền. 

Màu nền lúc này chuyển thành màu 

hồng (màu này sẽ bị xoá sau khi chọn 

OK). 

 

 

Chọn Ok để hoàn tất.   

Kết quả. 

 
II.4.8. Video, âm thanh 

II.4.8.1. Chèn video, âm thanh 

- Tại thanh trình đơn (Menu) chọn Chèn (Insert) →Video/Âm thanh (Sound). Khi đó 

sẽ xuất hiện cửa sổ trình duyệt. Bạn phải duyệt tới nơi chứa Video/Âm thanh cần 

chèn và chọn Open để chèn Video/Âm thanh vào. 

II.4.8.2. Chú ý: 

- Đối với phần mềm SMART Notebook chỉ hỗ trợ định dạng video *.flv, âm thanh là 

*.mp3. Để chèn các định dạng âm thanh khác thì bạn nên dùng phần mềm trung gian 

để chuyển đổi tệp tin âm thanh/video về dạng *.mp3/*.flv. 

- Mẹo: Bạn có thể chèn video/âm thanh (định dạng không được hỗ trợ) theo cách chèn 

một tệp tin bình thường. Nó sẽ hiển thị bằng biểu tượng/đường dẫn. Khi cần mở thì 

chỉ cần chọn vào biểu tượng/đường dẫn. 

II.5 Các thao tác cơ bản chung. 

II.5.1. Căn chỉnh đối tượng. 

-  Kéo chọn tất cả các đối tượng cần căn chỉnh. 

                       

- Trên thanh công cụ chọn . Khi đó sẽ có các lựa chọn sau: 

+    Căn đáy. 



                                                                                                             

 Trang - 23 -  
 

HDSD SMART NOTEBOOK 

+   Căn phải. 

+    Căn trái. 

+    Căn đỉnh. 

II.5.2. Sắp xếp đối tượng (Order). 

- Nguyên tắc khi một đối tượng được tạo ra trước thì sẽ nằm dưới đối tượng tạo sau.  

 
 

 

- Để sắp xếp lại thứ tự thì làm như sau. 

II.5.3. Khóa đối tượng (Lock). 

- Nếu muốn các đối tượng di chuyển theo ý mình thì bạn sẽ dùng chức năng Khóa 

(Lock). 

- Để tiến hành khóa đối tượng thì làm như sau: 

Thao tác Ảnh minh họa 

Chọn đối tượng cần sắp xếp. 

 

 

 

 

Chọn vào biểu tượng . Khi đó một 

thanh menu sẽ hiện ra. 

 

 

 

 

 

 

 Chọn Sắp xếp (Order). Ở đây sẽ có 4 lựa 

chọn. 

+ Đưa lên trên (Bring Forward). 

+ Đưa lên trên cùng (Bring to Front).  

+ Gửi về sau (Send Backward). 

+  Gửi về sau cùng (Send  to Front). 

 

 
 

Chọn 1 trong 4 lựa chọn trên để sắp xếp trật tự các đối tượng theo ý muốn. 
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II.5.4. Nhóm (Group). 

Dùng để nhóm từ hai đối tượng trở lên thành một. 

 

Thao tác Ảnh minh họa 

Chọn các đối tượng cần nhóm. 

 

 

Thao tác Ảnh minh họa 

Chọn đối tượng cần khóa. 

 

 

Chọn vào biểu tượng . 

 

 

 

 

Thao tác Ảnh minh họa 

Chọn Khóa (Lock). Khi đó có nhiều lựa chọn: 

+ Mở khóa (Unlock): mở khóa đối tượng 

trong trường hợp đã chọn Khóa tại chỗ (Lock 

In Place). 

+ Khóa tại chỗ (Lock In Place): đối tượng 

tại vị trí cố định, không thể di chuyển, không 

thể thao tác. 

+ Cho phép di chuyển theo chiều dọc 

(Allow  Vertical Move). 

+ Cho phép di chuyển theo chiều ngang 

(Allow Horizontal Move). 

+ Cho phép di chuyển (Allow Move): chỉ 

cho phép di chuyển nhưng mà không thể thao 

tác. 

+ Cho phép di chuyển và xoay (Allow Move 

and Rotate). 

 

 

 



                                                                                                             

 Trang - 25 -  
 

HDSD SMART NOTEBOOK 

 

Chọn vào biểu tượng  

 

 

 
 

Chọn vào Nhóm ( Group ) → chọn 

Nhóm (Group). 

 

 

 

 

  

II.5.5. Liên kết (Link).  

II.5.5.1. Liên kết với các công cụ 

 

Thao tác Ảnh minh họa 

Chọn đối tượng cần liên kết. 

 

 

 

Chọn vào biểu tượng  

 

 

 

 

 

 

 

 

Chọn Liên kết Công cụ (Link To Tool). 

Có 4 lựa chọn: 

+ Bút (Pen). 

+ Tẩy (Erase). 

+ Chọn (Select). 

+ None (Không): nếu muốn bỏ liên kết 

với công cụ thì chọn vào đây. 
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II.5.5.2. Liên kết với âm thanh. 

Thao tác Ảnh minh họa 

Chọn đối tượng cần gán âm thanh. 

 

 

Chọn vào  

 

 

Chọn Âm thanh.. (Sound..). Khi đó sẽ 

xuất hiện một cửa sổ. 

Chọn “Browse..” nếu muốn liên kết với 

tệp tin âm thanh có sẵn trong máy tính. 

Khi đó bạn cần duyệt tới nơi chứa âm 

thanh cần liên kết. 

 

Nhấn Open để liên kết. 

 

 

Nếu muốn ghi âm lại thì chọn Bắt đầu ghi 

âm (Star Recording) và ghi âm thanh của 

bạn lại. Chọn Nghe thử (Preview Sound) 

để nghe lại âm thanh vừa ghi. 

 

Chọn hiển thị như là biểu tượng nếu 

muốn có một biểu tượng nhỏ kèm theo 

(Conner icon). Hoặc chọn đối tượng nếu 

muốn liên kết trực tiếp (Object). 

 

 

Nhấn đính kèm âm thanh (Attach Sound) để hoàn tất. 
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II.5.5.3. Liên kết với các đối tượng khác. 

Thao tác Ảnh minh họa 

Chọn đối tượng cần liên kết. 

Chọn vào biểu tượng  

Chọn vào Liên kết (Link). Khi đó sẽ có một cửa sổ xuất hiện. 

 

Nếu muốn liên kết với một trang trình 

duyệt đa phương tiện nào đó thì chọn 

Trang Web ( Web Page) và nhập tên 

trang trình duyệt vào ô địa chỉ 

(Address). Tick vào hiển thị như là 

biểu tượng (Corner icon) hoặc tick vào 

Đối tượng (Object) khi muốn liên kết 

trực tiếp. 

 

Nếu muốn liên kết với một trang khác 

trong bài soạn thì chọn Một trang khác 

(Page in this File). Sau đó chọn một 

trang nào đó trong danh sách trang. 

Tương tự cũng có hai lựa chọn Hiển thị 

như là biểu tượng (Corner icon) hoặc 

Đối tượng (Object) cho bạn lựa chọn. 

Nhấn Ok để hoàn tất. 

 

 

Nếu một liên kết với một tệp tin nào đó 

trên máy tính thì chọn vào tệp tin trên 

máy tính (File on this Computer). Nhấn 

‘Browse..’ để duyệt tới tệp tin cần liên 

kết. 
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Thao tác Ảnh minh họa 

Nếu muốn liên kết với một tệp tin nào 

đó đã được chèn trong bài giảng thì 

chọn Đính kèm hiện tại (Current 

Attachments). 

 

 

                    

II.5.6. Thuộc tính đối tượng (Propeties). 

- Chọn vào đối tượng cần hiển thị thuộc tính. Sau đó chọn vào biểu tượng  (hoặc 

chọn chuột phải) → Thuộc tính (Properties). Khi đó bên trái phần thuộc tính  sẽ 

hiện ra như sau : 

 

Thao tác Ảnh minh họa 

Hiệu ứng tô đầy: màu nền các ô. 
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Kiểu viền/đường: màu, kiểu các ô. 

 

 

 

 

 

 

 

 

       

Kiểu văn bản: định dạng văn bản ở 

trong ô. 

 

Hiệu ứng đối tượng: Hiệu ứng cho 

bảng. 
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III. ADD-ONS: CÁC CÔNG CỤ HỖ TRỢ  

III.1 Concept map (Sơ đồ tư duy) 

III.1.1. Mô tả. 

 Dùng để sơ đồ hóa, thống kê tổng hợp kiến thức sau mỗi bài học. 

III.1.2. Cách sử dụng. 

Thao tác Ảnh minh họa 

Bước 1: Chọn “start a new concept 

map” trên thanh trình đơn (menu). 

Khi đó một nút gốc được hiển thị 

(root). 

 
 

Bước 2: Nhấn đúp chuột trái vào 

chính giữa ô để nhập văn bản vào. 

 

 

Bước 3: Chọn vào dấu ‘ +’ để tạo 

ra một nhánh con từ nút gốc, sau đó 

tiếp tục nhập văn bản cho nhánh 

con. 

 

 

Lưu ý: Tạo liên kết cho các nhánh dùng công cụ Bút (Pen) vẽ một nét từ nhánh này 

qua nhánh kia. 

- Sử dụng cho hình ảnh: Sau khi chèn hình ảnh vào. Ta sẽ dùng bút vẽ một vòng tròn, 

khi đó phần mềm sẽ tự động tạo một ô chứa hình ảnh đó. 
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III.2 Write Equation (Ghi công thức toán học). 

III.2.1. Mô tả. 

Dùng để ghi công thức toán học từ đơn giản đến phức tạp 

 

III.2.2. Cách sử dụng. 

 
 

III.3 Insert Equation (Chèn công thức toán học). 

III.3.1. Mô tả. 

Dùng để ghi công thức toán học từ đơn giản đến phức tạp. 

III.3.2. Cách sử dụng. 
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III.4 Recorder (Quay lại bài dạy). 

III.4.1. Mô tả. 

Công cụ bổ trợ này cho phép quay lại bài đã giảng dạy. 

 

III.4.2. Cách sử dụng. 

Thao tác Ảnh minh họa 

Chọn vào Lesson Recorder → 

New recording. 

 

 

Chọn vào ‘Stop Recording’ để 

dừng quay. 

 

 

   

Gõ nội dung và 

chọn công thức 

Chọn vào nút này 

để thêm vào trang  
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Sau đó chọn vào biểu tượng  

để chạy. 

 

 

III.5 SMART Block (Làm phép tính). 

III.5.1. Mô tả. 

Là công cụ hỗ trợ cho việc tính các phép toán đơn giản như + ; -; x; :. 

 

III.5.2. Cách sử dụng. 

Thao tác Ảnh minh họa 

Chọn vào biểu tượng 

SMART Block. 

Ở dưới sẽ có các phép tính 

hiện lên: 

 

Chọn 2 lần vào phép tính cần 

chèn vào trang. 

Dùng bút viết 2 con số muốn 

đặt phép tính. Sau đó dùng bút 

gạch một đường từ con số đến ô 

phép tính. Khi đó nó sẽ tự động 

đưa con số đó vào trong ô và tự 

tính ra kết quả. 

 

Chú ý đối với  : đối với Block này nó sẽ tạo ra phép tính ngẫu nhiên từ các phép 

tính còn lại. 

III.6 Image Web Search (Tìm kiếm hình ảnh). 

III.6.1. Mô tả. 

Cho phép tìm kiếm hình ảnh trực tiếp thông qua từ khoá. 
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III.6.2. Cách sử dụng. 

Nhập từ khoá muốn tìm hình ảnh, sau đó chọn biểu tượng kính lúp để trình duyệt 

thực hiện quá trình tìm kiếm. 

 

III.7 Youtube (Tìm kiếm video trên Youtube). 

III.7.1. Mô tả.  

Công cụ bổ trợ tìm kiếm hình ảnh trực tiếp trên mạng thông qua trình duyệt bing 

của Microsoft tích hợp theo phần mềm 

 

III.7.2. Cách sử dụng. 

Chọn “Search” xuất hiện bản tìm kiếm video trên Youtube, bằng cách nhập nội 

dung chủ đề muốn tìm sau đó chọn biểu tượng kính lúp, chương trình sẽ tự động 

tìm thông tin cần cho bạn qua từ khoá vừa nhập. 
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III.8 GeoGebra (Vẽ đồ thị hình học). 

III.8.1. Mô tả. 

Công cụ bổ trợ này thường sử dụng cho môn toán về đồ thị hàm số, hình học cơ bản, 

xác suất. 

 

III.8.2. Cách sử dụng.  

AddOn GeoGbra là phiên bản thu gọn của phần mềm hình học nổi tiếng GeoGbra, 

nó chỉ bao gồm phiên bản 2D và không hỗ trợ 3D. 

 
AddOn Geobra gồm có 3 thành phần chính: vùng làm việc, vùng các thao tác, và 

vùng tùy chọn. 
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III.9 Activity Buider (Công cụ xây dựng thùng chứa). 

III.9.1. Mô tả. 

 Là công cụ hỗ trợ việc xây dựng ứng dụng thùng chứa, sắp xếp phân loại theo các 

chủ đề khác nhau.  

III.9.2. Cách sử dụng.  

Ví dụ: tạo hai thùng chứa để phân loại hai chủ đề: số chẵn và số lẻ. 

Thao tác Ảnh minh họa 

Bước 1: Tạo các đối tượng như 

sau. 

 
Bước 2: Thiết lập cho thùng 

chứa. 

Chọn vào thùng chứa, sau đó 

(1) chọn vào biểu tượng Add-ons 

trên thanh bên, (2) chọn Edit để 

thiết lập. 

Cửa sổ ‘Object’ hiện ra, (3) 

Chọn ‘Add All Remaining’ ở 

phần ‘Accept these objects’ (chấp 

nhận những đối tượng này) .Tiếp 

đến (4) loại bỏ những đối tượng 

không thuộc thùng chứa bằng 

cách kéo thả các đối tượng không 

thuộc thùng chứa vào trong thùng 

rác. 

Cuối cùng (5) Chọn ‘Add All 

Remaining’ ở phần ‘Reject these 

objects’ (loại bỏ những đối tượng 

này) để thêm vào những đối 

tượng không thuộc thùng chứa. 
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Thao tác Ảnh minh họa 

Trong phần Settings: ta gán 

hiệu ứng vào ô kiểm tra khi có đáp 

án kéo vào. 

 + Các hiệu ứng cho đáp án đúng 

khi kéo vào ô kiểm tra: 

• None: không hiệu ứng gì. 

• Fade Out: biến mất. 

• Fly Out: bay ra ngoài rồi 

mất đi. 

• Snap to center: bám dính 

vào giữa 

• Spin: Quay tròn 

 + Hiệu ứng cho đáp án sai vào ô 

kiểm tra: 

• None: không hiệu ứng gì 

• Bounce back: trả lại  

Chọn Done để chấp nhận 

 

IV. Smart Lab 

IV.1 Mô tả. 

Các hoạt động chương trình đã có sẵn người dùng chỉ chọn những hoạt động theo 

chủ đề và sau đó điền nội dung cho hoạt động. Kết hợp với bộ trả lời trắc nghiệm, và 

được kết nối thông qua mạng internet. Các thiết bị kết nối được truy cập vào trang 

web: hellosmart.com. 

Bao gồm nhiều hoạt động theo các nhóm khác nhau: Fill in the blanks; Flip Out; 

Game Show; Label Reveal; Match ‘Em Up!;Monster Quiz; Rank Oder; Response2; 

Shout It Out!; Speedup; Super Sort 
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IV.2 Các hoạt động. 

IV.2.1. Fill In The Blanks (Điền vào chỗ trống). 

Nội dung Ảnh minh họa 

Nhập một đoạn văn bản hoàn chỉnh, 

muốn từ nào bỏ trống trong văn bản thì 

bôi đen chúng, những từ bôi đen sẽ xuất 

hiện phía dưới văn bản cho ta kéo vào 

chỗ trống .  

Chương trình có nhiều ảnh nền khác 

nhau cho ta lựa chọn. 

 

 

IV.2.2. Flip Out (Lật hình).  

Nội dung Ảnh minh họa 

Có 2 mặt, một bên là câu hỏi, một bên 

là đáp án. Khi xuất hiện câu hỏi, chọn 

lên câu hỏi sẽ được lật đáp án lên. 

 

 

 

 

 

 

IV.2.3. Game Show (Trò chơi quay bánh xe). 

Nội dung Ảnh minh họa 

Game show dưới hình thức chia làm 

2 đội, mỗi đội trả lời câu hỏi trúng thì 

được cộng điểm sai sẽ không được tính 

điểm, kết thúc ai nhiều điểm hơn sẽ 

thắng. 

Câu hỏi có 2 dạng đúng sai và  cho 

phép chọn đáp án đúng. 

 

 

IV.2.4. Label Reveal (Gắn nhãn cho đối tượng). 

Nội dung Ảnh minh họa 

Chú thích chi tiết cho đối tượng. 

Chèn đối tượng muốn chú thích, chọn 

lên chỗ cần chú thích, điền thông tin vào. 

Cho phép ẩn hiện chú thích trên đối 

tượng (Hide Labels). 
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IV.2.5. Match ‘Em Up!’ (kết hợp). 

Nội dung Ảnh minh họa 

Chọn những cặp đối tượng tương tự 

nhau, giống nhau thì kết hợp lại. 

 

 

 

 

 

 

 

 

IV.2.6. Monster Quiz (Trả lời câu hỏi nhanh). 

Nội dung Ảnh minh họa 

Trả lời câu hỏi hai dạng đúng sai và 

câu hỏi lựa chọn, yêu cầu phải kết nối 

với bộ trả lời trắc nghiệm hoặc điện thoại 

truy cập trang ‘https://hellosmart.com’ 

điền mã lớp học để trả lời đáp án. 

 

 

 

 

IV.2.7. Rank Oder (Thứ tự xếp hạng). 

Nội dung Ảnh minh họa 

Đây là dạng sắp xếp theo thứ tự từ  

trên xuống hoặc từ dưới lên, theo một 

trình tự. 

Chương trình có nhiều hình nền khác 

nhau. 

 

 

 

 

IV.2.8. Response2 (Trả lời thông qua thiết bị trắc nghiệm). 

Nội dung Ảnh minh họa 

Dạng này giống như Monster Quiz 

nhưng hình thức phong phú hơn: đúng 

sai, chọn đáp án đúng, điền từ thiếu, 

chọn nhiều đáp án đúng cùng một lúc, 

vv.. 
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IV.2.9. Shout it out  (Gây sự chú ý). 

Nội dung Ảnh minh họa 

Học sinh giao tiếp cho giáo viên 

thông qua thiết bị, học sinh gửi câu hỏi, 

hình ảnh, ý tưởng cho giáo viên. Hoặc 

học sinh trả lời câu hỏi của giáo viên. 

 

 

 

 

 

 

IV.2.10. Speedup (Đua xe tốc độ). 

Nội dung Ảnh minh họa 

Đây là trò chơi đua xe, mỗi trận đua 

có nhiều nhất 4 người chơi, kết hợp với 

trò chơi là trả lời câu hỏi trắc nghiệm, 

câu hỏi hai dạng đúng sai và câu hỏi lựa 

chọn, người chơi chọn trả lời đáp án trên 

màn hình. 

 

 

 

 

IV.2.11. Super Sort (Sắp xếp). 

Nội dung Ảnh minh họa 

Trò chơi dưới dạng thùng chứa, chia 

làm hai nhóm, đáp án nào theo chủ đề 

nhóm một sẽ cho vô nhóm một, đáp án 

theo chủ đề nhóm hai sẽ quay trở ra và 

ngược lại. 

 

 

 

 

 

 

 

 

 

 



                                                                                                             

 Trang - 41 -  
 

HDSD SMART NOTEBOOK 

V. Cách sử dụng và mở rộng tài nguyên  

V.1 Cách sử dụng. 

Thao tác Ảnh minh họa 

Tại thanh bên chọn  

 
Khi đó phần tài nguyên sẽ xuất hiện. 

Tài nguyên bao gồm nhiều thư mục để 

phân loại các chủ đề khác nhau. Chọn vào 

một thư mục nào đó thì bên dưới sẽ có các 

mục. 

+ Các hình ảnh. 

+ Tương tác và đa phương tiện. 

+ Têp tin Notebook và các trang. 

+ Nền và Theme. 

+ 3D. 

 

 
Thao tác Ảnh minh họa 

Chọn vào một trong các mục ở phía 

dưới để hiển thị các tài nguyên chứa bên 

trong. 

Chọn chuột trái 2 lần hoặc kéo thả 

những hình ảnh, âm thanh, video, mẫu… 

vào trong trang bên để sử dụng. 

 
- Ghi chú :  

+ Theme là những mẫu trang được thiết lập trước (Có thể tự xây dựng). 

+ Phần mềm SMART hỗ trợ định dạng 3D. 
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V.2 Mở rộng. 

Khi bạn muốn cất giữ những tài nguyên riêng của chính bạn để thuận tiện trong quá 

trình sử dụng thì làm như sau: 

V.3 Các hoạt động trong kho tài nguyên online. 

Smart lab còn cung cấp kho tài nguyên trực tuyến, chúng ta có thể lưu về  máy 

tính và chỉnh sửa lại nội dung cho phù hợp. 

 

 

Thao tác Ảnh minh họa 

Trên thanh bên, tại  thư viện tài nguyên, 

nhấp phải chuột vào Tài nguyên của tôi (My 

Content) Chọn Thư mục mới (New folder) 

để tạo. 

 

 
 

Thư mục mới được tạo.  

 
 

 

Đặt lại tên thư mục cho phù hợp. 

 
Kéo thả những đối tượng mà bạn muốn lưu 

giữ vào trong thư mục vừa tạo. 
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Thao tác Ảnh minh họa 

Ta vào kho tài nguyên  chọn ‘Smart 

Lab Activities’ → Click here. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Sẽ xuất hiện trang web chứa các kho tài 

nguyên, chọn hoạt động thích hợp sau đó tải 

về máy.  

 

 
Sau khi tải về ta mở lên chọn biểu tượng 

cây bút để chỉnh sửa lại. 

Chọn cây bút ở góc phải trên cùng chỉnh 

nội dung lại. 

 

 

Tương tự sử dụng cho các hoạt động khác. 
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V.4 Các hoạt động mẫu. 

Các hoạt động này nằm trong kho tài nguyên       khi cài đặt chương trình này. Sau đó chọn 

ví dụ các hoạt động bài học (Lesson Activity Example) sẽ có Activity Builder, Interactive 

Techniques, 3D Objects. 

V.4.1. Các hoạt động đã xây dựng (Activity builder). 

 

Ta sẽ thấy có 6 ảnh và 19 hoạt động mẫu: Answer 

check 1, Answer check 2, Fill in the blanks 1, Fill in 

the blanks 2 , Freeform 1, Freeform 2, Labelling1, 

Labelling2, Labelling3, Labelling4, Matching 1, 

,Matching 2,  Ordering 1, Ordering 2, Ordering 3, 

Sorting1, Sorting 2, Sorting3, Sorting 4 

 

 

 

V.4.2. Đáp án câu hỏi dạng thùng chứa (Answer check 1, Answer check 2) 

- Cho câu hỏi có nhiều đáp án, kéo thả đáp án đúng sẽ cho phép vào, đáp án sai sẽ 

quay trở lại. Sử dụng thuộc tính thùng chứa. 

Anwer check 1. 

Mô tả Ảnh minh hoạ 

Bước 1: Vào thư viện tại tài nguyên, 

Click đúp vào Answer check 1. 

 Chọn 1 trong 3 đáp án bên dưới kéo thả 

vào ô kiểm tra đáp án. 

     + Đúng: đáp án sẽ được giữ lại trong ô 

kiểm tra. 

     + Sai: đáp án sẽ trả lại vị trí ban đầu. 

 
Bước 2: Cách thiết lập. Xem chi tiết  phần thùng chứa trang 36. 
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V.4.3. Các kỹ thuật xây dựng tương tác (Interactive Techniques). 

V.4.4. Chọn và hiển thị (Click to reveal 1, Click to reveal 2). 

- Có 2 đối tượng chồng lên nhau, khi chọn vào đối tượng phía trên thì nó sẽ mất đi, 

ta sẽ thấy đối tượng bên dưới. 

Click to revreal 2: 

Thao tác Ảnh minh hoạ 

Bước 1: Vào thư viện tại tài 

nguyên, nhấp đúp vào ‘Click to 

reveal 2’. 

Kết quả của các phép tính sẽ hiện 

lên sau khi ta chọn vào hình dấu 

chấm hỏi. 

Trước tiên ta phải có 2 đối tượng 

là phép tính và hình dấu chấm hỏi. 

Để hình dấu chấm hỏi đè lên kết 

quả phép nhân. 

 

 

Bước 2: Để làm đấu chấm hỏi 

biến mất ta làm như sau. 

Chọn mũi tên màu đen bên phải 

phía trên (  ) để mở thuộc tính 

của đối tượng ( bạn cũng có thể 

nhấp chuột phải đối tượng ) → 

chọn Properties… 

Xuất hiện giao diện thuộc tính 

Object Animation. 

 
 

Ta sẽ thấy có 5 ảnh flash và 10 hoạt động 

mẫu: Click to reveal 1,  Click to reveal 1, 

Color reveal-method 1, Color reveal-

method2, Color reveal-method3, Drap to 

target, Esear to reveal, Layer reveal, Object 

animation, Pull tab. 
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Thao tác Ảnh minh hoạ 

Ta cần thay đổi thông số sau: 

+ Type : Fade Out (chọn kiểu  

biến mất). 

+ Speed: Fast ( tốc độ nhanh). 

+ Occurs: when the object is 

clicked ( khi nhấp chuột lên 

đối tượng). 

Tương tự làm cho các hình dấu 

chấm hỏi còn lại. 

 

VI. Cách trình chiếu, giảng dạy trực tiếp. 

VI.1 Chuẩn bị trước khi giảng dạy/trình chiếu. 

VI.1.1. Cài đặt chế độ hiển thị. 

- Phần mềm SMART Notebook cho phép hiển thị nhiều chế độ hiển thị khác nhau, bạn 

có thể dễ dàng phóng to, thu nhỏ, chú giải trên màn hình máy tính. 

- Trước khi giảng dạy thì cần chú ý đến việc tùy chỉnh màn hình hiển thị sao cho phù 

hợp. 

- Để phóng to thu nhỏ thì sử dụng  trên thanh Công cụ: 

VI.1.2. Toàn màn hình. 

- Chọn vào khi đó ở bên góc dưới trái có những công cụ cơ bản 

sau: 

Hiển thị vị trí trang/tổng số trang  

Nút di chuyển trang  
Thêm trang mới 

 
Quay lại một thao tác  
Chọn  

 
Bút thần kỳ 

 dùng để phóng to/bộ hiển thị 

Các công cụ khác chọn vào để hiển thị nhiều công cụ hơn 

Tự động căn chỉnh 
 

Thoát chế độ toàn màn hình 
 

Mở rộng thu hẹp thanh công cụ 
 

VI.1.3. Chú giải màn hình. 

- Chọn vào  để thực hiện chú giải trên màn hình desktop. 
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- Ở dưới cũng có thanh công cụ cơ bản giống như chế độ toàn màn hình. 

VI.1.4. Hiển thị 2 trang cùng lúc. 

- Chọn vào  để hiển thị 2 trang cùng lúc. Mục đích để so sánh 

trang trước và trang sau. Hoặc để 1 trang là câu hỏi, 1 trang là câu trả lời. 

VI.1.5. Phóng to thu nhỏ. 

- Có nhiều lựa chọn để điều chỉnh độ lớn của màn hình hiển thị. 

 

VI.1.6. Tự động căn chỉnh. 

 
Màn hình sẽ tự động căn chỉnh theo chiều dọc 

 
Màn hình sẽ tự động căn chỉnh theo chiều ngang 

VI.1.7. Hiển thị các liên kết.   

- Sau khi soạn xong, nếu bạn quên bạn đã gán liên kết nào cho đối tượng nào thì sẽ 

dùng cách sau để hiển thị các liên kết đã gán. 

- Tại trang chứa các đối tương liên kết, trên thanh trình đơn (Menu) Chọn Xem(View) 

→ Hiển thị tất cả liên kết khi trang được mở (Show All Links When Page Opens). 

- Khi đó các đối tượng trên trang nếu có liên kết thì sẽ hiện ô vuông nhấp nháy bao 

quanh. 

 

VI.2 Sử dụng các công cụ để giảng dạy/trình chiếu. 

VI.2.1. Sử dụng bút thần kỳ. 

- Khi bạn muốn viết chữ và chữ tự động biến mất sau một khoảng thời gian thì sẽ sử 

dụng công cụ bút thần kỳ. 

+ Chọn Bút thần kỳ trên thanh công cụ  
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+ Viết lên trang và sau khoảng thời gian xác định nó sẽ tự động biến mất. 

- Để điều chỉnh thời gian tự động biến mất thì làm như sau: 

Nội dung Ảnh minh họa 

Chọn Bút thần kỳ trên thanh công cụ  

Bên thanh bên chọn vào  

Chọn số giây 

 
Khi bạn muốn nhấn mạnh 1 đối tượng nào 

đó ngoài việc sử dụng bút dạ quang thì có thể 

sử dụng bút thần kỳ. 

Chọn bút thần kỳ trên thanh công cụ   

Vẽ một vòng tròn quanh đối tượng cần nhấn 

mạnh. 

Khi đó sẽ xuất hiện một đèn chiếu, chiếu vào 

đối tượng cần nhấn mạnh. 

 
 

 

Nếu bạn muốn phóng to để nhấn mạnh một 

đối tượng nào đó thì làm như sau : 

Vẽ một hình chữ nhật quanh đối tượng cần 

nhấn mạnh. 

Khi đó đối tượng sẽ được phóng to. Hình 

chữ nhật lúc này giống như là kính lúp. 

 

 
 

 

VI.2.2. Sử dụng bút văn bản (Cho môn ngoại ngữ). 

- Chỉnh sửa văn bản trực tiếp bằng bút, nhận dạng chữ viết (tiếng Anh). 

+ Nhận dạng chữ viết tay: Chọn bút văn bản trên thanh công cụ  , thiết lập 

màu, độ trong mờ..v.v và sau đó viết vào trang. 

 
+ Chỉnh sửa văn bản: 
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VI.2.3. Trình chiếu tệp tin 3D. 

- Phần mềm SMART Notebook hỗ trợ các định dạng 3D như : *.dae; *.fbx; *.obj; 

*.skp. 

- Bạn có thể thiết kế hình ảnh 3D với phần mềm Sketchup hoặc có thể tìm kiếm các 

định dạng 3D trên internet. Sau khi đã có trong tay 1 tệp tin 3D thì bạn sẽ chèn vào 

trang soạn thảo và bắt đầu trình chiếu. 

+ Trên thanh Trình đơn (Menu) chọn Chèn (Insert)→ Tệp tin 3D. 

+ Tiến hành trình chiếu. 

Chức năng Mô tả Minh họa 

Xóa  Gạch ngang văn bản cần xóa 
 

Chèn khoảng 

trắng 

Gạch dọc tại vị trí cần chèn 

khoảng trắng  

Chèn văn bản - Vẽ biểu tượng ^ tại nơi cần 

chèn văn bản. 

- Viết văn bản mới tại khung 

văn bản. Chữ viết sẽ được nhận 

dạng và chuyển sang chế độ văn 

bản. 

- Chọn  để chấp nhận chuyển 

đổi, hoặc chọn  để từ chối. 

 

Thay thế văn 

bản 

- Vẽ vòng tròn xung quanh văn 

bản cần thay thế. 

- Viết vào khung văn bản mới 

xuất hiện. Chữ viết sẽ được nhận 

dạng và chuyển sang văn bản. 

- Chọn  để chấp nhận chuyển 

đổi, hoặc chọn  để từ chối. 

 

Thay thế màu 

sắc văn bản 

- Chọn một màu cần thay đổi 

trong bảng màu  . 

- Vẽ vòng trong quanh văn bản 

cần đổi màu. 

- Chọn  để chấp nhận chuyển 

đổi, hoặc chọn  để từ chối. 

  

Thay thế màu 

sắc cho từ 

- Chọn một màu cần thay đổi 

trong bảng màu  . 

- Vẽ 1 hình bầu dục ngang văn 

bản cần đổi màu. 

- Chọn  để chấp nhận chuyển 

đổi, hoặc chọn  để từ chối. 
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- Có 2 cách trình chiếu: 

 Cách 1: Sử dụng trực tiếp trên trang. 

 
Thao tác Ảnh minh họa 

Xoay quanh trục dọc. 

 
Xoay quanh trục ngang. 

 
Xoay quanh trục đứng.  

 

 
Xoay tự do. 
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Cách 2: Sử dụng chế độ trình chiếu 3D. 

+ Chọn vào đối tượng 3D, bấm chuột phải → Chế độ trình chiếu 3D. 

+ Khi đó sẽ hiển thị màn hình trình chiếu chuyên biệt cho định dạng 3D. 

- Thiết lập tệp tin 3D: 

- Thêm chú thích cho hình ảnh 3D: bạn có thể thêm các chú thích cho hình ảnh 3D 

để tăng tính trực quan cho bài giảng của mình. Các bước làm như sau: 

Thao tác Ảnh minh họa 

Nhập nhãn chú thích cho đối tượng: định 

dạng văn bản trước khi nhập. 

 

 
Chế độ cải trang: dùng mũ ảo thuật để cải 

trang cho hình ảnh 3D. Để sử dụng thì làm 

như sau: 

+ Chọn vào hình ảnh 3D. 

+ Chuột phải → Cải trang → Cải trang. 

+ Chọn vào biểu tượng mũ ảo thuật ở góc 

dưới trái thì hình ảnh 3D sẽ hiển thị. 

 

VI.2.4. Sử dụng các công cụ đo lường. 

- Được sử dụng trong môn toán, các môn học liên quan đến đo lường. 

- Nó bao gồm các công cụ sau: 

Thao tác Ảnh minh họa 

Xoay quanh trục ngang. 

 
Xoay quanh trục đứng. 

 

Xoay quanh trục dọc. 

 
Thoát khỏi chế độ trình chiếu 3D. 
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Thao tác Ảnh minh hoạ 

 Thước kẻ 
 

 Ê kê 

 

 Thước đo độ 

 

 Compa 

 
 

+ Chọn  trên thanh công cụ để mở các công cụ đo lường. 

+ Chọn một công cụ đo lường và tiến hành đo. 

VI.3 Các công cụ để soạn trước. 

VI.3.1. Tạo nhóm trang. 

- Dùng để quản lý các trang, phân chia thành các nhóm trang. Giúp quá trình đặt nền 

cho trang nhanh hơn…v.v.. Ví dụ có thể phân chia 2 nhóm trang: một là nhóm lý 

thuyết,  hai là nhóm bài tập.   

- Cách tạo và quản lý nhóm trang. 

Thao tác Ảnh minh hoạ 

Tại thanh bên chọn  để mở trình 

duyệt trang. 

Tại trình duyệt trang chọn để hiệu 

chỉnh nhóm trang. 
 

Chọn ‘Add New Group’ để thêm 

nhóm mới. 

Đặt tiêu đề cho nhóm trang. 

 

 
Kéo thả các trang vào các nhóm trang tương ứng. 
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VI.3.2. Sử dụng Theme. 

- Bạn có thể đặt nền cho từng trang bằng cách sử dụng đặt nền thông thường. Xem 

thêm phần thao tác với trang. 

- Theme là các giao diện trang được thiết lập sẵn, sử dụng theme tiết kiệm thời gian 

đặt nền cho các trang, dễ dàng quản lý với những mẫu bài giảng khác nhau. 

- Cách tạo theme. 

 

Thao tác Ảnh minh hoạ 

Trên thanh trình đơn, chọn Định dạng 

(Format) → Theme → Tạo Theme mới 

(Create new theme). 

 

 

 

 

 

  

Thiết lập Theme. 

Chọn Lưu (Save) để lưu lại theme vừa 

tạo. Khi đó Theme vừa tạo sẽ nằm trong 

thư viện tài nguyên phần thư viện của 

tôi. 

 

 

 

 

 
Để gán Theme cho các trang thì làm 

như sau: 

Vào thư viện tài nguyên → Tài nguyên 

của tôi (My Content) → Nền và themes 

(Backgrounds and Themes) → Chọn 

một Theme nào đó. Hoặc có thể nhập 

tên Theme ở ô tìm kiếm tại trang tài 

nguyên: 

 

 

Khi kéo một Theme nào đó vào thì 

một cửa sổ xuất hiện. 

Nhấp chọn một trong các lựa chọn: 

+ Thêm Theme cho tất cả các trang 

(Insert theme on all page). 
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❖ TỔNG HỢP CÁC PHÍM TẮT TRONG SMART NOTEBOOK 
o Alt + Enter >> Trình chiếu toàn màn hình 

o Ctrl + { >> Căn lề trái 

o Ctrl + | >> Căn giữa 

o Ctrl + } >> Căn lề phải 

o Ctrl + < >> Giảm kích cỡ của chữ 

o Ctrl + = >> Subcript 

o Ctrl + > >> Tăng kích cỡ của chữ 

o Ctrl + 1 >> Select 

o Ctrl + 2 >> Pen 

o Ctrl + 3 >> Creative pen 

o Ctrl + 4 >> Eraser 

o Ctrl + 5 >> Line 

o Ctrl + 6 >> Shape 

o Ctrl + 7 >> Fill 

o Ctrl + 8 >> Text 

o Ctrl + 9 >> Magic pen 

o Ctrl + A >> Chọn tất cả đối tượng 

o Ctrl + B >> Kiểu chữ in đậm 

o Ctrl + C >> Copy (sao chép) 

o Ctrl + D >> Clone (nhân đôi) 

o Ctrl + G/R >> Gộp/ tách nhóm 

o Ctrl + I >> Kiểu chữ in nghiêng 

o Ctrl + K/J >> Khóa/ Mở khóa đối tượng 

o Ctrl + L >> Xóa hết nội dung có trên trang 

o Ctrl + M >> Tạo trang mới 

o Ctrl + N >> Tạo project mới 

o Ctrl + O >> Mở file 

o Ctrl + P >> In 

o Ctrl + PgDn >> Sắp xếp đối tượng xuống dưới 

o Ctrl + PgUp >> Sắp xếp đối tượng lên trên 

o Ctrl + S >> Lưu 

o Ctrl + Shift + = >> Superscript 

o Ctrl + Shift + E >> Khóa nhưng cho phép di chuyển theo chiều dọc 

o Ctrl + Shift + H >> Khóa nhưng cho phép di chuyển theo chiều ngang 

+ Thêm Theme vào tất cả các trang 

của nhóm hiện tại (Insert theme on all 

pages of current group). 

+ Chỉ thêm Theme vào trang hiện tại 

(Insert theme on current page only). 
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o Ctrl + Shift + PgDn >> Sắp xếp đối tượng xuống dưới cùng 

o Ctrl + Shift + PgUp >> Sắp xếp đối tượng lên trên cùng 

o Ctrl + Shift + V >> Khóa nhưng cho phép di chuyển 

o Ctrl + U >> Kiểu chữ gạch chân 

o Ctrl + V >> Dán 

o Ctrl + X >> Cắt 

o Ctrl + Y >> Redo (Đến thao tác vừa mới thực hiện) 

o Ctrl + Z >> Undo (trở về bước trước đó) 

o F1 >> Help 

o F4 >> Properties 

 

❖ THÔNG TIN LIÊN HỆ HỖ TRỢ KỸ THUẬT 
Hotline: 1900 96 96 59 

Email: cskh.bhbt@gmail.com 

mailto:cskh.bhbt@gmail.com
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